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1 IMPORTANT 
PLEASE READ THIS MANUAL, PARTICULARLY THE SAFETY INFORMATION, BEFORE ATTEMPTING 
TO USE THE INSTRUMENT.  IT IS ALSO IMPORTANT THAT YOU RETAIN THE MANUAL FOR FUTURE 
REFERENCE.  BIODETECT AS CANNOT BE HELD RESPONSIBLE FOR ANY DAMAGE CAUSED AS A 
RESULT OF ANY USER NEGLECTING TO READ THE MANUAL. 

1.1 DISCLAIMER 
Your YeastCyte has been carefully designed, constructed and tested and is supplied in good faith.  However, 
attention is drawn to BioDETECT AS’s Terms and Conditions of Sale.  
 
BioDETECT AS shall have no liability or responsibility to the customer or any other person or entity with respect to 
any loss or damage caused or alleged to be caused directly or indirectly by equipment or software sold or furnished 
by us, including, but not limited to, any interruption of service, loss of business or anticipatory profits or 
consequential damages resulting from the use or operation of the equipment or software.  
 
This manual is for guidance only.  The information in this manual is subject to change without notification and 
additional pages may be inserted in future editions.  BioDETECT AS assumes no responsibility for any omissions or 
errors in the present edition. 

1.2 SAFETY INFORMATION 

1.2.1 General 
The YeastCyte flow cytometer is designed for use only by suitably trained persons, in a laboratory or industrial 
environment and must never be used for household, diagnostic or therapeutic purposes.  For safety reasons, the 
YeastCyte should not be operated in ambient temperatures above 30ºC, and must never be used in potentially 
explosive atmospheres. 

1.2.2 Electrical and Optical Safety  
The YeastCyte uses an external mains power unit – MASCOT, model 2020.  This unit meets the requirements of 
EN60950 and is CE marked by the manufacturer.  No other mains power supply should be used.  The power supply is 
for indoor use only, and must be kept dry.  There are no user-serviceable parts inside the power supply - do not open. 
Use the mains lead provided to connect to a suitably fused mains supply in the range 100-240 V AC.  The power unit 
is double insulated, so an earth connection is not essential.  
 
The YeastCyte itself have one external fuse (3.15 A (T)), and only this type should be used as replacement.  The 
YeastCyte must not be operated with the cover removed.  The instrument generates high internal voltages, and 
contains a LASER, both of which could be hazardous without the cover.  The YeastCyte is a CLASS 1 LASER 
PRODUCT when cover is on. 
 
 
 

 
Figure 1 Laser with position of warning 

 
 
The internal optical block is classified as a CLASS 3B laser product.  No parts should be removed or replaced and no 
modifications or adjustments should be made without the approval of BioDETECT AS. Do not continue using a 
damaged or faulty instrument.  
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1.2.3 Biological Hazards 
If hazardous micro-organisms are used with the YeastCyte, the whole instrument must be treated as potentially 
hazardous.  The fluid system cannot be considered safe until it has all been thoroughly cleaned with a suitable 
disinfecting fluid.  It is the responsibility of the user to check the suitability of the disinfecting method used.  The 
possibility of leaks in the fluid system should also be taken into account when disinfecting the instrument.  

1.2.4 Other hazards 
Suitable precautions should be taken when using radioactively-labelled organisms or particles.  Some chemicals used 
in sample preparation are hazardous and will accumulate in the fluid system.  Some fluorescent dyes are potential 
carcinogens and are not destroyed by autoclaving.  Take suitable precautions in all cases and confer with your local 
regulations.  For electromagnetic compatibility information, see Appendix 1. 

1.3 Symbols and abbreviations 
CV Coefficient of variation 

PI Propidium iodide 

LED Light-emitting diode 

PBS Phosphate buffered saline 
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2 DESCRIPTION OF THE INSTRUMENT 

2.1 General working principle 
The YeastCyte system consists of three parts: (i) a built in liquid handling system that mixes the yeast sample and 
the dye buffer (PI). (ii) A built in optical system (flow cytometer) that measures the light scatter and fluorescence 
from the stained yeast cells and (iii) a computer system analysing and presenting the measurements.  A schematic 
presentation of the working principle is illustrated in Figure 2. 
 

 
Figure 2 A schematic illustration of the working principle of the YeastCyte system 

 
1. The sample (approx. 5 ml) is pumped through the pipette and the Dye Buffer Solution is pumped from the Dye 

Buffer container and mixed at a ratio of 1:2, one part sample and two parts Dye Buffer. 

2. The mixture is passed through the reaction loop.  

3. A small amount of the sample/Dye Buffer mixture is pumped to the flow cell by the measuring pump. This pump 
delivers a known volume (1.5 µl per second) to the flow cell.  

4. The majority of the mixture is collected in the high concentrated waste container (see section 2.5.1). 

5. In the flow cell the sample/Dye Buffer mixture is deposited in a laminar stream of Sheath liquid and hit by a 
laser beam (excitation wavelength 532 nm).  

6. When the cells pass the beam they give off scattered - and fluorescent light (>570 nm), which is detected by two 
detectors. The signals are processed by the computer to generate the counts and histogram of the sample. 

7. The spent sheath liquid containing the analysed yeast sample is delivered as low concentrated waste (see section 
2.5.2). 

8. The pumping of Sheath liquid is controlled by a differential pressure transducer. In this way, the flow through 
the flow cell is stable and not effected by the fluid levels of the Sheath liquid and the Waste containers. 
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2.2 The front 

 
Figure 3 Front of YeastCyte 

(1) Light Emitting Diodes: 
GREEN: Ready, insert sample 
RED:  Busy, processing a sample, washing or in stand by mode. 
GREEN/RED FLASHING:  Waiting, sample must be removed before proceeding with the analysis. 

(2) Pipette with liquid sensor. 
(3) Tray for collection of effluent from the pipette. 

2.3 The rear panel 

 
Figure 4 The rear panel of YeastCyte 

(1) Timer. 
(2) Button for manually draining of the drawer in the front. 
(3) Connection of tubing for dye buffer (Dye buffer solution). 
(4) Connection of tubing for high concentrated waste (Waste high conc.). 
(5) Connection of tubing for low concentrated waste (Waste low conc.). 
(6) Connection of tubing for sheath liquid (Sheath rinse liquid). 
(7) Jack for 12 V DC supply. 
(8) Main switch. 
(9) Mains fuse (3.15 A (T)). 
(10) RS232 C serial port for connection to PC. 

1 

2 

3 

1 

2 

3 

4 

5 

6 

7

8

9

10



 
                  

YeastCyte   User Handbook 
Version no. 
1.1 

 

Date 
30.01.2007 

 

Page 
7 (18) 

 

 

2.4 Liquid input 

2.4.1 Sheath rinse liquid 
Deionised and sterile filtered water supplemented with Tween 20 (0.1%) and Na-acid (0.1%) is used as sheath rinse 
liquid. Mix e.g. 10.0 l of water with 10.0 ml of Tween 20 and 10.0 g Na-acid.  Connect tubing to the rear panel (point 
6 in Figure 4). 

2.4.2 Dye buffer solution 
Propidium iodide (PI) is used as fluorescent labelling substance. The dye is dissolved in PBS. Protect the dye buffer 
solution from light (dark bottles) and connect to the rear panel (point 3 in Figure 4). 

2.5 Waste output 

2.5.1 High concentrated waste 
The sample and the dye buffer solution are mixed in the reaction loop. Only a small fraction of the mixture (approx. 6 
%) is actually pumped further to the flow cell for measurement. Thus most of the reaction mixture (approx. 94%) is 
pumped directly to waste. This is collected as high concentrated waste (point 4 in Figure 4). This waste consists of 
33% yeast sample and 66% dye buffer solution. Dispose off according to local regulations. 

2.5.2 Low concentrated waste 
The low concentrated waste (point 5 in Figure 4) consists mainly of the spent sheath liquid containing some yeast and 
only traces of dye buffer solution. The drain from the drawer in the front (liquid from pipette washing) is also 
collected in the low concentrated waste, and may normally be drained to the sink. 
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3 DESCRIPTION OF THE SOFTWARE 

3.1 Program window 

3.1.1 General 
The program window of YeastCyte (Figure 5) consists of a menu bar, tool bar, and frames for data, histogram, id 
and status. 
 

 
Figure 5 The YeastCyte program window 

3.1.2 Data Frame 
The Data Frame contains a grid where results stored in the database files are displayed.  The grid displays eight 
columns and a number of rows, one for each sample (see Figure 5). The last sample is listed at the bottom whilst the 
oldest will appear at the top. The grey column to the left holds the index of the sample.  The column holds the 
following information: 

− Batch No 
The operator provides this information via the Batch No field in the Id Frame.  The maximum length of 
this field is 8 characters. 

− Id 
The operator provides this information via the Id field in the Id Frame.  The maximum length of this field 
is 12 characters. 

− Dilution 
The operator provides the information via the Dilution Factor field in the Id Frame.  The maximum length 
of this field is 5 characters. 

− Total 
This column shows the total yeast cell count x 1 million (cells/ml) of the original sample, this calculation is 
based on the information given in the Dilution Factor field.  The program calculates this value when the 
sample is analysed.  

− Dead 
This column shows the number of stained cells (dead cells) x 1 million (cells/ml).  The program calculates 
this value when the sample is analysed.  
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− % Dead 
This column shows the number of dead yeast cells divided by the total number of cells x 100. 

− Time 
This column shows the time when the sample is started.  Format is HH:MM. 

− Remark 
The operator may provide this information via the Edit Result Line dialogue.  The maximum length of this 
field is 30 characters. 

 
The date of the results in the grid is displayed in the title of the Data Frame.  The sample currently highlighted will 
be displayed in the histogram. 

3.1.3 Histogram Frame 

 
Figure 6 Histogram Frame 

 
The Histogram Frame shows the histogram of the yeast cells in the sample.  The red colour indicate cells that have 
been stained with PI (dead cells) whilst the blue part of the histogram indicates unstained cells (light scatter only).  
From the Options Chart menu, it is possible to show or hide the scale on the Y and X-axis.  There is also an option to 
select between automatic or fixed scaling.  When Options Chart ► Auto Scale is not selected, it will be possible to 
change the scale with the up/down control arrows. 

3.1.4 Id Frame 

 
Figure 7 Id Frame 

• Batch No field 
The Batch No field is writable. The maximum length is 12 characters.  The content of this field is copied to the 
corresponding field in the Results Frame both when a sample is started and when the sample is finished. 
 
• Id field 
The Id field is writeable.  The maximum length is 8 characters.  The content of this field is copied to the 
corresponding field in the Results Frame both when a sample is started and when the sample is finished. 
 
• Dilution Factor field 
The Dilution Factor field is writeable; the maximum length is 5 characters.  The content of this field is copied to the 
corresponding Dilution field in the Results Frame.  The Dilution Factor field should contain the dilution factor 
used preparing the sample, the instrument uses this to calculate the amount of cells in the original sample.  The result 
is shown in the Results Frame.  
 
• Pressure Indicators 
The pressure indicators will give information about the pressure of the pump system in the instrument. 
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3.1.5 Status Frame 

 
Figure 8 Status Frame 

The Status Frame has a progress bar and a Message field.  The progress bar shows the progress during the 
different sequences of the analysis.  Status messages and instructions to the operator are displayed in the Message 
field. 

3.1.6 Menu Bar 
The Menu Bar contains menu entries to control the functionality of the program (see section 3.2). 

3.1.7 Tool Bar 
The Tool Bar contains buttons to access menu functions that are most commonly used.  Each button has a tool-tip 
text that is displayed when the mouse pointer is placed over the button. 

 

 
Figure 9 Tool Bar 

3.2 Menus 

3.2.1 File menu 
The File menu will have the following sub-menus: 

• Open… 
The Open function will display the Open Results dialogue (Figure 10) giving access to the results stored in the 
Results directory.  The dialogue will give information about the following items: 
− The date of each result file. 
− The number of samples in each file. 
 

 
Figure 10 Open Results dialogue 

The Open menu will not be available during a sample run. 

• Export Data… 
The Export Data function makes it possible to export results from the Data Frame to a file in separated xls 
format.  The Export Data menu will not be available during a sample. 

• Print ► 
The Print menu gives access to the following print functions: 

− Results… 
This function prints out a result report.  It is possible to select between print all or print the selected results in 
the Data Frame.  More than one result can be selected by holding down the Shift-key and marking multiple 
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results.  This can also be done by simply holding down the left mouse button and then moving the mouse up 
or down the table.  

− Histogram… 
This function will print the displayed histogram together with the corresponding results from the Data 
Frame.  

− Screen... 
This function will print the program window. 

The Print menu will not be available during a sample. 

• Print Setup… 
The Print Setup function will give access to the Print Setup dialogue.  This function will not be available during 
a sample. 

• Exit 
The Exit function terminates the program immediately when only the software is started.  The Exit menu will 
only be available when User Access Level is set to Privileged User and not during a sample.  Ordinary users have 
to exit the program through the Shut Down procedure. 

3.2.2 Edit menu 
The Edit menu will have the following sub-menus: 

• Edit Result… 
The Edit Result menu entry will give access to the Edit Result dialogue.  This dialogue will display information 
from the selected result line in the Data Frame.  This can be done either by selecting the Edit Results menu, 
short-cut Ctrl+E or by double clicking the sample.  Fields that can be edited is displayed with white background.  
Locked fields are displayed with grey background.  The Remark field will always be open to edit.  The Batch No 
and Sample Id fields will be open to edit if the last collected sample is opened. 

3.2.3 Operation menu 
The Operation menu will have the following sub-menus: 

• Start Sample 
The Start Sample menu will initiate the analysis if the pipette is immersed into liquid. 

• Fill 
The Fill menu will activate the Fill function.  This function is only available for Privileged User.  

• Run 
The Run menu entry will activate the Run function.  This function is only available for Privileged User.  The 
pump for back-flushing the pipette must be disabled before activating the Run function. 

• Start Up 
The StartUp menu entry will activate the Start Up function (see section 4.2). 

• Stand By 
The Stand By menu entry will activate the Stand by mode (see section 4.5). 

• Shut Down 
The Shut Down menu entry will activate the Shut Down function (see section 4.6). 

• Clean 
The Clean menu entry will activate the Clean function.  This is used if cleaning of the instrument is required 
during normal operation.  Follow the instructions on screen. 

3.2.4 Options menu 
The Options menu will have the following sub-menus: 

• Port Configuration… 
The Port Configuration menu will open the Port Configuration dialogue where it is possible to select which port 
to use and whether the port shall be open or closed. The program will remember the selected port and the port 
state, even if the computer is turned off.  The Port Configuration menu will not be available during a sample. 

• Auto Start  
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The Auto Start menu entry will enable/disable the Auto Start function.  Enabled Auto Start will be indicated by a 
check mark ( ) in front of the menu entry.  When Auto Start is check marked, the instrument will automatically 
start a sample when a liquid is placed at the pipette.  The program will remember this setting, even if the 
computer is turned off. 

• Auto Numbering  
The Auto Numbering menu entry will enable/disable the Auto Numbering function. Enabled Auto Numbering will 
be indicated by a check mark ( ) in front of the menu entry.  When Auto Numbering is check marked, a number 
inserted in the Id field will automatically increase by one for each new sample.  The program will remember this 
setting, even if the computer is turned off. 

• Chart ► 
The Chart menu will have the following sub-menus: 
− Auto Scale  

The Auto Scale menu entry will enable/disable the Auto Scale function.  This function turns the Auto Scale 
function for the axis of the histogram on or off.  Enabled Auto Scale will be indicated by a check mark ( ) 
in front of the menu entry.  When Auto Scale is check marked, the size of the histogram will automatically 
adjust to the histogram frame.  The program will remember this setting, even if the computer is turned off. 

− Show X-Scale  
The Show X-Scale menu entry enables/disables the Show X-Scale function.  This function displays or hides 
the scale on the X-axis of the histogram.  Enabled Show X-Scale will be indicated by a check mark ( ) in 
front of the menu entry.  The program will remember this setting, even if the computer is turned off. 

− Show Y-Scale  
Same function as with the Show X-Scale, regarding the Y-axis. 

• Default Window Size 
This function restores the window to default size. 

• Discriminator… 

Discriminator Limit sets the level (channel number) at which the automatic discriminator starts operating.  This 
can only be done by a Privileged User. 

• User Access Level… 
The User Access Level menu entry will open the User Access Level dialogue where it will be possible to select 
between Ordinary and Privileged user level.  If a change from Ordinary to Privileged user level is selected, a 
Password will be required. 

• Change Password… 
The Change Password menu entry will open the Change Password dialogue, where it will be possible to change 
the password for access to the Privileged User level.  The default password when the program is started the first 
time will be "password".  This function is only available for Privileged User. 

3.2.5 Help menu 
The Help menu will have the following sub menus: 
• YeastCyte User Handbook 

The YeastCyte User Handbook menu will give access to this manual in a pdf file format.  This requires that the 
YeastCyte CD-ROM is inserted in the computer’s CD drive. 

• About 
The About menu will open the About dialogue where information about the program version will be available. 
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4 ROUTINE ANALYSIS 
A ’splash’ screen with the BioDETECT logo will be displayed when the program is loaded and during the start-up 
sequence. The user will be requested to do certain tasks to prepare the instrument through dialogues as described in 
the following. 

4.1 Selection of COM port 
The very first time the YeastCyte program is started, the user will be requested to select which COM port to use. 
The program will store the selected COM port number in the Windows registry for use next time the program is 
started.  

4.2 Start up 
In order to ensure proper working conditions, the YeastCyte has to go through a certain start up procedure before 
analysis can be performed.  This procedure lasts for 6 minutes.  Before starting up the YeastCyte, perform the 
following operations: 
 
• Prepare all solutions (sheath rinse liquid, dye buffer solution and rinsing solution) and connect the tubes to the 

instrument. 
• Check that the computer is connected to the instrument and turn on both units. 
• Select the YeastCyte program from the START UP menu on the computer. 
• Follow the instructions on the screen (see Figure 11) 
 
 

 
Figure 11 Start Up dialogue 

4.3 Sample preparation 
The yeast slurry must be diluted in an appropriate buffer (e.g. PBS) prior to measurement.  The number of yeast cells 
in the sample to be measured should be in the range 2 x 105  - 1.2 x 106 cells/ml for best results.  A standardised 
dilution factor of e.g. 1:1000 is recommended.  Ensure that there are no lumps in the yeast to be measured, if 
necessary strain the sample through a 100 µm filter before pouring it into an appropriate container. 

4.4 Measurement 
The total time for a measurement is approximately 60 seconds.  This includes different phases of filling, priming and 
counting.  After the filling phase the user will be asked to remove the sample.  When this is done, the instrument 
continues the measurement for a while before presenting the results on screen.  During the measurement perform the 
following operations:     
 
• Fill in the Batch No, Id and Dilution Factor in the Id Frame. 

• Tilt out the pipette and put the sample container under it.  Hold the container by hand during the filling phase, or 
place it on the shelf by tilting the pipette back to the vertical position.  

• Initiate measurement: 

- by clicking the Start Sample button on the Tool Bar, or 

- by selecting the Start Sample entry in the Operation menu. 
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If Auto Start is selected from the Options menu, measurement will be initiated automatically when the pipette senses 
contact with liquid.  

• Wait while the analysis is performed.  When “Remove sample” appears on screen, remove the sample by tilting 
the pipette outwards and then leave it in this position.  Do not insert the next sample until the message "Insert 
sample" appears on screen, informing that the instrument is ready for a new sample. 

• When the counting phase is completed, the results will appear on the lowest unused row in the Data Frame.  
The corresponding histogram will appear in the Histogram Frame on the right side of the screen.  Based on 
the information given in the Dilution Factor field, the system calculates the amount of cells in the original yeast 
sample. 

4.5 Stand by 
If the instrument is to be left without use for a short while, select Stand By from the Operation menu.  In this mode 
the pipette will be rinsed and the main pump run for 30 seconds every 30th minute, keeping the instrument in a status 
ready to run new samples.  If the instrument is left for 10 minutes without use, the stand by mode will be initiated 
automatically.  The dialogue box in Figure 12 will be displayed. 
 
 

 
Figure 12 Stand By Mode dialogue 

4.6 Shut down 
At the end of the day, the YeastCyte must be shut down according to a specified procedure.  This is done to ensure 
proper cleaning of the instrument.  This procedure lasts for 3 minutes.  To shut down the instrument perform the 
following operations: 
 
• Select Shut Down from the Operation menu. 
• Put the pipette into rinsing solution 
• Follow the instructions on the screen.  
• When the cleaning cycle is completed, remove the chemicals and empty the waste containers.  Then switch off 

the instrument (see Figure 13). 
 
 

 
Figure 13 Shut Down dialogue 
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5 WARRANTY  
This Limited Warranty defines the restrictions and warranty period that apply to the BioDETECT instrument that you 
have purchased. The warranty provides free parts and labour for one year from date of product purchase (the 
"Warranty Period'").  Contact BioDETECT AS (www.biodetect.no) if you have questions about this Limited 
Warranty. 

5.1 Terms of the Warranty  
BioDETECT warrants that the product you have purchased from BioDETECT or from a BioDETECT authorised 
reseller is free from defects in materials or workmanship under normal use during the Warranty Period, which 
commences on the date of purchase.   
Should the product require service during the term of the Limited Warranty, BioDETECT will repair or replace the 
defective part(s) with a new part(s), or at BioDETECT's discretion a used part(s) that meets or exceeds the 
performance specifications for new parts.  In some cases, BioDETECT will ship a new user- replaceable part(s) direct 
to you, or at BioDETECT's discretion a used part(s) that meets or exceeds the performance specification for new 
parts.   All exchanged parts and products replaced under this warranty will become the property of BioDETECT.  
In the unlikely event that your product has a recurring failure, BioDETECT at its discretion, may elect to replace the 
product with a comparable replacement.  
This product is covered by the BioDETECT World-wide Warranty for YeastCyte instruments.  Warranty Service 
may vary from country to country; warranty terms of the servicing country apply.  BioDETECT is not responsible for 
any handling fees, import duties, or tariffs.  
This Limited Warranty extends only to products initially purchased from BioDETECT or from a authorised reseller.  
This Limited Warranty does not extend to any product that has been damaged or rendered defective (a) as a result of 
accident, misuse, or abuse; (b) as a result of an act of God; ( c) by operation outside the usage parameters stated in the 
product's user documentation; (d) by the use of parts not manufactured or sold by BioDETECT; (e) by modification 
of the product; or (f) as a result of service by anyone other than BioDETECT or a BioDETECT authorised service 
provider.  BioDETECT is not responsible for damage to or loss of any programs, data, or removable storage media.  
Contact BioDETECT Services for geographic restrictions, response time commitments, and other specific service 
requirements or available services.  
 
EXCEPT AS EXPRESSLY SET FORTH IN THIS WARRANTY, BIODETECT MAKES NO OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING ANY IMPLIED WARRANTIES OF MERCHANT 
ABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  BIODETECT EXPRESSLY DISCLAIMS ALL 
WARRANTIES NOT STATED IN THIS LIMITED WARRANTY.  ANY IMPLIED WARRANTIES THAT MAY 
BE IMPOSED BY LAW ARE LIMITED TO THE TERMS OF THIS EXPRESS LIMITED WARRANTY.  

5.2 Limitations of Remedy  
BioDETECT is not liable for any damages caused by the product or the failure of the product to perform, including 
any lost profits, lost savings, incidental damages, or consequential damages.  BioDETECT is not liable for any claim 
made by a third party or made by you for a third party.  This limitation applies whether damages are sought, or a 
claim made, under this warranty or as a tort claim, a contract claim, or any other claim.  This limitation cannot be 
waived or amended by any person.  This limitation of liability will be effective even if BioDETECT or an authorised 
representative of BioDETECT has been advised by you of the possibility of any such damages.  This limitation of 
liability, however, will not apply to claims for personal injury.  
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APPENDIXES    

APPENDIX 1   Electromagnetic Compatibility 
This equipment conforms to the requirements of the EC directive 89/336/EEC. The Radio Frequency emissions 
from the equipment are very small - below the limits set in EN55011, and should not cause any problems in a 
typical laboratory or industrial operating environment.  The equipment also has good immunity to mains-borne 
interference and static damage as required by IEC801. 
 
Because the YeastCyte has extremely sensitive wideband detectors and amplifiers, it can be disturbed by very 
high local radio frequency fields. In certain circumstances, false peaks could appear on the display.  Users should 
therefore avoid using mobile phones, or other transmitters, close to the instrument when making measurements. 
Without such local RF sources, typical RF background fields will cause no problems. 
 
Screened cable should be used for the RS 232 C serial connection, with the shield grounded to the plug shell.  
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APPENDIX 2   Technical specifications 
 
Light source 5 mW laser diode, nominal wavelength 532 nm. 
Light scatter detector Photo diode, wavelength 536 nm+/- 5 nm. 
Light scatter sensitivity 2-20 µm, measured with mono disperse particles. 
Light scatter resolution CV 5% at 500.000 cells/ml. 
Fluorescence detector Avalanche photo diode, wavelength 550-900 nm. 
Fluorescence resolution CV 5% at 500.000 cells/ml. 
Flow cell Closed flow channel 0.25 x 0.25 mm. 
Sample 5 ml. 
Concentration range 2x104 – 1.2x106 particles per ml. 
Power supply 13.2 VDC, 4.5A, from mains adapter (100-240 VAC 50/60 Hz). 
Connections - One 2.5 mm jack for DC supply.   

- RS232C, 9 pin D-type (male).  
- Four tube connections for external containers for sheath fluid, dye 
buffer, high and low waste. 

Dimensions 340x230x500 mm 
Weight 14.2 kg 
Trademarks YeastCyte  is a registered trade mark of BioDETECT AS. 

Propidium iodide (PI) is trade marks of Molecular Probes, Inc.  
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APPENDIX 3   Optionals and consumables list 
 
3010 YeastCyte Reagent Kit For rapid and reproducible staining of 

dead yeast cells 
3020 YeastCyte bottle and tube kit  
3030 YeastCyte service contract 1 year  
 


